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Getting Started

The first task to accomplish is to create names and locations with Administer Names and 
Administer Locations.

Then you can use the Punch In, Punch Out and Find.



Find Employee Location

The Find command will display a dropdown list box that is used to search for a name.    The 
name can either be typed in with the keyboard, scrolled through with the cursor keys, or 
click the left mouse button on the dropdown button and select by positioning the cursor over
the desired name and clicking the left mouse button.

Punch will automatically fill in the current location and return time for the employee 
selected.    Also, the current status of the message waiting light will be updated.

At the bottom of the screen will be a Message Waiting button that can be turned on or off to 
signal the employee to call the front desk or secretary to pick up new messages.

Supplemental location information may be viewed by clicking on the Info... button once an 
employee is selected.



Message Waiting

The Message Waiting button appears in both the Punch In and Find Employee screens.    
Generally, it should be used by a secretary or receptionist to signal to an employee that 
there is a message waiting for them at the reception/secretary desk.

It may be turned on or off in either screen by positioning the cursor over it and clicking the 
right mouse button.



Punch In

To punch in, select Punch In from the main menu.

The Punch In screen will appear with a single dialog box available.    

If you are logged in under Novell 3.12, your log in name will appear automatically.    If not, 
you can either start typing in your name until the proper name appears or position the 
cursor over the drop-down arrow and click the mouse button.    From that point a list of 
names to choose from will appear.    Use the scroll bar or arrow keys to scroll through the 
names available.    Click once on the proper name.

Hit <ENTER> or click on the OK button.



Punch Out

To punch out, select Punch Out from the main menu.

The Punch Out screen will appear with three dialog boxes across the top.    The first is for 
your name.    The second is for the location you are going to.    The third is for your return 
time.

To enter your name, if you are logged in under Novell 3.xx, your log in name will appear 
automatically.    If not, you can either start typing in your name until the proper name 
appears or position the cursor over the drop-down arrow and click the mouse button.    From 
that point a list of names to choose from will appear.    Use the scroll bar or arrow keys to 
scroll through the names available.    Click once on the proper name.

Hit the <TAB> key.    The cursor will now be in the locations box.    Either select a name from 
the list available using the mouse or cursor keys, or type in a location of your choice.

Hit the <TAB> key.    The cursor will now be in the return time box.    Either select a time from
the list available using the mouse or cursor keys, or type in a return time of your choice.

Hit the <TAB> key.    If you want to enter additional information about where you are going, 
hit the <ENTER> key or click on the Info button.
 
Info... You can clear all supplemental information by clicking on the Clear button.    You can 
type in any information in the available boxes.    Use the <TAB> key to move between boxes.
Click on the OK button to save the supplemental information or click on the CANCEL button 
to not save the information you have entered.

After all information has been entered, click on the OK button to save or the CANCEL button 
to not save.



Lock Keyboard

Locking the keyboard can be a time saver.    If you are in Windows and logged into a network,
it can be troublesome to exit windows and log out of the network to secure your machine 
when you leave, only to have to log in again and re-start Windows when you return.

If you lock the keyboard, the screen will clear and wait for the correct password to be 
entered to release the keyboard.

To lock the keyboard, select Lock Keyboard from the main menu.

The lock keyboard screen will appear with two boxes for you to enter and re-enter your 
password.

Enter a password.    Hit the <TAB> key, then enter your password again.

To lock the keyboard and clear the screen, click on the OK button.    The screen will clear.    
Note that all programs running, even in other windows sessions, will halt until the keyboard 
is unlocked.

To cancel the operation, click on the CANCEL button.

To re-activate your keyboard, type in your password and hit the <ENTER> key.



Administration Menu

Use the Administration Menu to add, delete and change names and locations.

To use the Administration Menu, click on the Administration selection from the main menu.

You will be presented with two choices Administer Names and Administer Locations.    Use 
these for their respective tasks.



Administer Names

This option is used to add or delete names.    It is selected from the Administration Menu.

To add a name, type in a new name and click on the ADD button.

To delete a name, select the name that you want to delete by either using the arrow keys or 
by clicking on the desired name.    Then click on the DELETE button.

See also:    Names



Names

In general, Names are either the real or login names of the people that you want to keep 
track of.

If you are using Novell 3.xx use network login names and PUNCH will fill in the name 
automatically in the Punch In and Punch Out screens.

Note:    When using Punch In, Punch Out or Find, you can only enter a name that has been 
created with Administer Names.

See also:    Administer Names



Administer Locations

This option is used to add or delete locations.    It is selected from the Administration Menu.

To add a location, type in a new name and click on the ADD button.

To delete a location, select the location that you want to delete by either using the arrow 
keys or by clicking on the desired location.    Then click on the DELETE button.

See also:    Locations



Location

A location is used to indicate where a person is going when punching out.

See also:    Administer Locations



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the <<YourApp>> window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Punch 2.0 and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Punch v. 2.0 is Copyright 1993, 1994 by 
The VisAeon Corporation
33 Greenwood Avenue
Port Chester, NY    10573
914-939-2579



Title Bar

Punch v 2.0
The title bar is located along the top of a window.    It contains the name of the application 

and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Punch window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Punch window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>




